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Are you writing a paper but forgot the 
source of your information?
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BasicX7 Basic 
Workshop

X7
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Outline

1. What is EndNote X7?
2. Install EndNote X7
3. Importing Bibliography
4. Create Groups4. Create Groups
5. Cite While You Write
6. Back up and Share
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What is

A software that:
•Stores and organizes references found 
from many sources

•Inserts these citations into a Word 
document.document.

•Automatically format your references 
according to a predefined citation style
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My EndNote Library
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Citation
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Bibliography
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Installing

EndNote X7
٨٢
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• Make sure no applications are running, including 
virus protection software, Microsoft Word, or 
OpenOffice.org applications.
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1.Download a compressed file from 
library webpage and save it on your 
desktop.
2.You need to right-click to decompress 
the filethe file

Double-click the left one to run the program
and do not delete the license, or you only can
use the EN for 30 days trial.



٢٦/١١/١٤٣٥

١١



٢٦/١١/١٤٣٥

١٢



٢٦/١١/١٤٣٥

١٣



٢٦/١١/١٤٣٥

١٤



٢٦/١١/١٤٣٥

١٥



٢٦/١١/١٤٣٥

١٦



٢٦/١١/١٤٣٥

١٧

Typical installs only the most popular 493 output styles,

Typical

filters, and connection files. Limiting the number of files
installed speeds up performance

Custom
Custom contains more than 5000 output styles to 
choose.
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Start to build up your EndNote Library

Create My Personal EndNoteCreate My Personal EndNote 
Library
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Your Personal EndNote Library
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If you want to move the EN Library from 
desktop to Flash drive or other spaces, 
please remember to copy these two files
together.

To save PDFs, Excel, word or figures…

To save and edit the references
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Groups Panel tabs Panel

Search panel

reference List Panel 

reference Panel 

Layout panel
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Start to build up your EndNote Library

IMPORT BIBLIOGRAPHIES
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Searching an online database
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1. Pubmed

a) Method 1: Search in databases and export citations (PubMed)

b)Method 2: Search PubMed directly in EndNote
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2

1. Pubmed (Method 1)

1

3

4
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Double Click
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1. Pubmed (Method 2)

2

33

1
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2. Google Scholar
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Manually Create a Reference in EndNote



٢٦/١١/١٤٣٥

٤٤

1. Select New Reference from the References menu to create a new reference.

Or select New Reference button to add a new reference.
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2. Select the Reference Type from the drop-down list of available reference 
types. 

3.Enter the information for each field.

Note:
Author names can be entered either
First Name Last Name (Mary Lin) or
Last Name First Name (Tom Wu)Last Name, First Name (Tom, Wu),
because EN identifies everything before the
comma as the author’s last name.
You need to press the enter key to go
to the next line to enter the second author.
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Attach File

Attach Figure

click on the
close button
at the upper

corner of
the record.

Click on the “Yes”
button to save the

record.

up to 45 total attachments per record

Only one Figure

Note: You do not need to fill in all fields.
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Find Full Text

• If you don’t have the full text article of a reference in youry y
library, EN can try to find it for you.

• Select the references in your EndNote Library and run the
Find Full Text command.

• If the full text article is freely available on the internet or if• If the full text article is freely available on the internet or if
you have access to it through a subscription, EN will try to
download it for you and attach it to the references.
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Find Full Text

Select all and right-
click

Select Find Full Text
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You can read any pdfs attached to your library using EN’s built-in
pdf viewer and make notes using the annotation tools.
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Importing PDF File

If you have one PDF or a PDF
folder sitting on your hard drive,
EndNote can import the pdfs into

lib d t th d tyour library and create the records at
the same time.
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Importing PDF Folder

1. From the File menu, select Import > Folder

2. Click the Choose button to open the Browse

for Folder dialog. Select the needed PDF folder.
If the selected folder contains sub-folders, click
the "Include files in all sub-folders“ button.
Check “create a Group Set for this import” canCheck create a Group Set for this import can
create groups .
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Importing PDF Automatically

1. From the Edit menu, select 
Preference to edit PDFPreference…to edit PDF 
Handling setting.

2. Check “Enable automatic
importing”.

3 Cli k “S l t f ld ” b tt t3. Click “Select folder” button to
choose a folder that you want to
import PDF files automatically
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Manage references and full texts efficiently.

CREATE GROUPS

٥٣
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3.Select the references you want

Create Group

y
to add to the new group, then
click and drag them to the
group.

4.The new group now contains all
the references dragged to it.

1.To create a custom
group, select create
group from the groups
menu.

2.Type in the name of the
new group and press the
enter key.
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Smart Group
Smart Groups are based on a search strategy and will automatically
update, so you don’t have to drag the references to a smart group.

1.Select create smart group from the groups menu.
2.Type in the name of the new smart group.
3.Build your search strategy for the group. Title contains “Hormone”.
4.Click on the create button to create the smart group.
5.All the references with the term “Hormone” are now shown in the new smart group.
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From Groups
Creating a group based on existing groups.

1.Select “create from group” from the groups menu.
2.Type in the name of the new group.
3.The new group I’m creating here will show me only the references appearing in 
the selected groups.
4.Click on the create button to create the from group.



٢٦/١١/١٤٣٥

٥٨

Find Duplicates
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Get your references from EndNote into your word document

CITE WHILE YOU WRITE
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Add references to your paper

1.Place your cursor where you want to insert a citation.

2.Click on the go to EndNote button2
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3.Select a reference or set of references to insert.
If you wish to insert multiple references, hold down the control key
while selecting the references.

4.With the references selected, select the “Insert Citation” button on the
EndNote toolbar.
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5.You are returned to word and the references are inserted at the cursor location.
6.Once again, the bibliography and citation are instantly formatted.
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Format Bibliography

1.Open the format bibliography command by selecting the
small arrow at the button right of the bibliography group.

2.The first tab, Format bibliography, allows you to select 
the bibliographic style to be used in your document from 
a drop-down list.

3.If you want to add a new style, select the browse button 
to bring up a list of the styles installed on your computer.

4. Select the style you want to use

5.If you would like the citations in the document to be 
hyperlinked to the matching references in the 
bibliography, you can turn hyperlinking on in this screen.
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1.On the layout tab you can select the

Format bibliography

font and font size that will be used for
your entire bibliography.

2.You can add a title, such as reference.

3.If you want to format that title
differently, selecting the title’s text,
then selecting the text format buttonthen selecting the text format button,
will let you change the font for just the
title.
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Format bibliography

• First line indent will change the indentation of
the first line of each reference.

• Whether or not there is a hanging indent is setWhether or not there is a hanging indent is set
in the style, but in this window you can
change the width of that hanging indent.

• The line spacing option applies to all the text
in the bibliography.

• The space after option allows you to add extra
spaces between references.

• When all options are set, you select the ok
button to apply the changes.
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Formatted citations contain hidden field codes, 
indicated here by the gray shading, and if you try to 
delete text from a formatted citation or type directly 
into it, those changes will disappear the next time the 
bibliography updates. The correct way to edit citations 
is to run the Edit and manage citations command.is to run the Edit and manage citations command.
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Remove Citation:

1 For the grouped citation we

Edit & Manage Citations

1.For the grouped citation, we 
can remove one of the citations 
from the group.

2.Select the Edit and manage
citations command.

3.Select the citation to be
removed and choose “remove
citation” from the drop-down
list.
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Insert Citation :

Ch th i t it ti ti f

Edit & Manage Citations

• Choose the insert citation option from
the drop-down list at the right.

• This brings up the find citation
window.

• Perform my search for the new
reference then select the insert button.
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• Edit library reference would

Edit & Manage Citations

y
switch to the EndNote program
and open the record for viewing
or editing.

• Update from my library: The
citation in the paper will bep p
updated to match the library.
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Add Information:

Edit & Manage Citations

• I want to add information to the reference,
indicate that the item is in table 2 on page 10.

• In the pages field I will add the page number.

• Note that the pages field will only work with
bibliography styles that require page numbers.

• And type “see” in the Prefix field.

• In the suffix field I will add “, Table 2.”
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Categorize References

1. Click ”Group References by Custom Categories”.

2.Click “Configure Categories…” to set Categories.

1

2
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1. Click the Category name and Right click to rename or 
add Category headings.
2. Choose “All Reference in Bibliography” to select 
references and drag them to the category
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Insert citation on the Microsoft PowerPoint

1. Click “Style” menu to select a style that you need.
2. Click Insert Citation or Insert Selected Citation(s).
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Insert references on the Microsoft PowerPoint

1. Click “Style” menu to select a style that you need.
2. Click Insert Reference or Insert Selected    Reference(s).
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Remove Field Codes
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• You need to remove Cite While 
i fi ld d b f

Remove Field Codes

You Write field codes before you 
hand over your document to a 
publisher or colleague.

• On the EndNote tab, in the 
Bibliography group, select Convert 
Citations and Bibliography and
then Convert to Plain Textthen Convert to Plain Text. 

• A copy of the document, without 
field codes, appears in a new 
document window.

The copy does not contain Cite While 
You Write field codes, so you cannot 
reformat with Cite While You Write.
Keep the original document for editing 
by Cite While You Write.
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ENDNOTE OFFERS MORE THAN 5,000 BIBLIOGRAPHIC STYLES

A new reference style

٨٢
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Choosing already exist style
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1. Go to Edit- Output styles-Open style manager

Adding a new style
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ecographyecography
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Download the style you want to install
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• Double-click the style file. It should 
open in EndNote.

• In EndNote, go to “File Menu” and 
choose “Save As”. Replace the word 
“copy” with your style’s name and click py y y
“Save”.

• Click on “File Menu” and choose “Close 
Style”
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Bring your EndNote Library anytime, anywhere ,and easy to share with others.

BACK UP AND SHARE

٨٢
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EndNote Backup and Share

1. Open the EndNote library. From the
File menu, select Compressed Library
(.enlx)

2. select "Create.“
3. select “With or Without File
Attachments.”

4. select the scope of compressed file.
5. Click Next to display a file dialog.
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• Use the file dialog to save the
EndNote Compressed Library and
give it a filename

• To open the compressed file by
double- clicking the file.g
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Export Traveling Library

EndNote creates a hidden “traveling” library containing only the
references used in each paper. This traveling library is part of the
coded information contained in each citation. Use this command tocoded information contained in each citation. Use this command to
export the references (exclude Notes, Abstract, Figure & Caption) in
this traveling library to a regular EndNote library.
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Naglaa Elarabany, PhD
Lecturer of animal physiologyLecturer of animal physiology

Zoology department, faculty of science
Damietta university


